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CHAPTER ONE 

INTRODUCTION  

1.1  Background  

The Student Industrial Work Experience (SIWES) is the accepted skills training 

programme which form part of the approved minimum academic standard in the various 

degree programme for all the Nigerian Universities and Polytechnics. It is an effort to bridge 

the gap existing between the theory and practice of Engineering, Technology, Science, 

Agriculture, Medical and other professional education programmes in Nigeria Institutions.  

The minimum duration of the SIWES is 16 weeks for Engineering and Technology 

program in the Polytechnic. The Scheme has triple program involving the Student, 

Polytechnic and Industry. The triple program is well recognized throughout Nigeria.  

It is found by the Federal Government of Nigeria and jointly coordinated by the 

Industrial Training Fund (ITF) and the National Association of Universities, Polytechnic 

and Technical Schools. The major important factor that makes the Federal Government of 

Nigeria to establish Student Industrial Work Experience Scheme is the development of 

students brain toward what they have been taught in the school i.e the practical aspect.  

1.2  History of student industrial work experience scheme  

SIWES was established by Industrial Training Fund in 1997 to solve the problem of 

inadequate practical knowledge by Nigerian Graduates of Tertiary Institutions.  

The Scheme exposes students to industrial based skills necessary for a smooth 

transition from theory to practical and also its affords students of tertiary institutions the 

opportunity of being familiarized and exposed to the needed experience in education 

institutions. Participation in SIWES has become a necessary precondition for award of 

diploma and degree certificate in specific discipline in most institutions of higher learning 

in Nigeria, in accordance with the education policy of government.  

1.3  The Objectives of SIWES  

  The objectives of the Industrial Work Experience Scheme are to:-  



(i) Prepare the students for the work situation that they likely to meet after 

graduation or nearest in the future.  

(ii) Provide and avenue for students in the Nigeria Universities, Polytechnics 

and Technical Schools to transfer theoretical knowledge to practical skills.  

(iii) Create room for student to apply the theoretical knowledge which has been 

promote the technological development and passed from the teacher to the 

student to the practical work.  

(iv) Enlist and strengthen employer’s involvement in the education process of 

preparing Universities, Polytechnic and Technical School graduates for 

employment in industry.  

(v) Familiar students with work methods and machinery that may not be 

available in the schools which will help students in machineries and 

equipment handling.  

  



CHAPTER TWO 

2.1 Historical background of the study 

      Legit venture opposite marvelous Hotel..Kwara state Ilorin 

2.2 What is Computer 

A computer is an electronic device that manipulates information, or data. It has the ability 

to store, retrieve, and process data. You may already know that you can use a computer to type 

documents, send email, play games, and browse the Web. You can also use it to edit or 

create spreadsheets, presentations, and even videos. 

2.3 Types of Computer 

Analog computers 

Analog computers use continuous physical magnitudes to represent quantitative information. At 

first they represented quantities with mechanical components but after World War II voltages were 

used; by the 1960s digital computers had largely replaced them. Nonetheless, analog computers, 

and some hybrid digital-analog systems, continued in use through the 1960s in tasks such as 

aircraft and spaceflight simulation. 

Digital computers 

In contrast to analog computers, digital computers represent information in discrete form, 

generally as sequences of 0s and 1s (binary digits, or bits). The modern era of digital computers 

began in the late 1930s and early 1940s in the United States, Britain, and Germany. The first 

devices used switches operated by electromagnets (relays). Their programs were stored on 

punched paper tape or cards, and they had limited internal data storage. For historical 

developments, see the section Invention of the modern computer. 

Mainframe computer 

During the 1950s and ’60s, Unisys (maker of the UNIVAC computer), International Business 

Machines Corporation (IBM), and other companies made large, expensive computers of 

increasing power. They were used by major corporations and government research laboratories, 
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typically as the sole computer in the organization. In 1959 the IBM 1401 computer rented for 

$8,000 per month (early IBM machines were almost always leased rather than sold), and in 1964 

the largest IBM S/360 computer cost several million dollars. 

Minicomputer 

Although minicomputers date to the early 1950s, the term was introduced in the mid-1960s. 

Relatively small and inexpensive, minicomputers were typically used in a single department of an 

organization and often dedicated to one task or shared by a small group. Minicomputers generally 

had limited computational power, but they had excellent compatibility with various laboratory and 

industrial devices for collecting and inputting data. 

Microcomputer 

personal computer and peripherals A personal computer and its peripherals. A microcomputer is a 

small computer built around a microprocessor integrated circuit, or chip. Whereas the early 

minicomputers replaced vacuum tubes with discrete transistors, microcomputers (and later 

minicomputers as well) used microprocessors that integrated thousands or millions of transistors 

on a single chip. In 1971 the Intel Corporation produced the first microprocessor, the Intel 4004, 

which was powerful enough to function as a computer although it was produced for use in a 

Japanese-made calculator. In 1975 the first personal computer, the Altair, used a successor chip, 

the Intel 8080 microprocessor.  

Laptop computer 

The first true laptop computer marketed to consumers was the Osborne 1, which became available 

in April 1981. A laptop usually features a “clamshell” design, with a screen located on the upper 

lid and a keyboard on the lower lid. Such computers are powered by a battery, which can be 

recharged with alternating current (AC) power chargers. The 1991 PowerBook, created by Apple, 

was a design milestone, featuring a trackball for navigation and palm rests; a 1994 model was the 

first laptop to feature a touchpad and an Ethernet networking port.  
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Embedded processors 

Another class of computer is the embedded processor. These are small computers that use 

simple microprocessors to control electrical and mechanical functions. They generally do not have 

to do elaborate computations or be extremely fast, nor do they have to have great “input-output” 

capability, and so they can be inexpensive. Embedded processors help to control aircraft and 

industrial automation, and they are common in automobiles and in both large and small household 

appliances. One particular type, the digital signal processor (DSP), has become as prevalent as the 

microprocessor. DSPs are used in wireless telephones, digital telephone and cable modems, and 

some stereo equipment. 

 

What is software? 

Software is a set of instructions, data or programs used to operate computers and execute specific 

tasks. It is the opposite of hardware, which describes the physical aspects of a computer. Software 

is a generic term used to refer to applications, scripts and programs that run on a device. It can be 

thought of as the variable part of a computer, while hardware is the invariable part. 

The two main categories of software are application software and system software. An application 

is software that fulfills a specific need or performs tasks. System software is designed to run a 

computer's hardware and provides a platform for applications to run on top of. 

Other types of software include the following: 

i. Programming software, which provides the programming tools software developers need. 

ii. Middleware, which sits between system software and applications. 

iii. Driver software, which operates computer devices and peripherals. 

Examples and types of software 

Among the various categories of software, the most common types include the following: 
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 Application software. The most frequently used software is application software, which is a 

computer software package that performs a specific function for a user or, in some cases, for 

another application. An application can be self-contained, or it can be a group of programs that 

run the application for the user. Examples of modern applications include office suites, 

graphics software, databases, database management programs, web browsers, word 

processors, software development tools, image editors and communication platforms. 

 System software. These software programs are designed to run a computer's application 

programs and hardware. System software coordinates the activities and functions of the 

hardware and software. In addition, it controls the operations of the computer hardware and 

provides an environment or platform for all the other types of software to work in. An operating 

system (OS) is the best example of system software; it manages all the other computer 

programs. Other examples of system software include firmware, computer language translators 

and system utilities. 

 Driver software. Also known as device drivers, this software is often considered a type of 

system software. Device drivers control the devices and peripherals connected to a computer, 

helping them perform their specific tasks. Every device that's connected to a computer needs 

at least one device driver to function. Examples include software that comes with any 

nonstandard hardware, including special game controllers, as well as the software that enables 

standard hardware, such as USB storage devices, keyboards, headphones and printers. 

 Middleware. The term middleware describes software that mediates between application and 

system software or between two different kinds of application software. For example, 

middleware lets Microsoft Windows talk to Excel and Word. It's used to send a remote work 

request from an application in a computer that has one kind of OS to an application in a 

computer with a different OS. It also lets newer applications work with legacy ones. 

 Programming software. Computer programmers use programming software to write code. 

Programming software and programming languages, such as Java or Python, let developers 

develop, write, test and debug other software programs. Examples of programming software 

include assemblers, compilers, debuggers and interpreters. 
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CHAPTER THREE 

3.0 COMPUTER HARDWARE 

i. Central Processing Unit (CPU) 

It is responsible for processing information from programs run by your computer. It is referred to 

as the brain of the computer system. Each CPU has a clock speed that represents the number of 

instructions it can process in any given second, measured in gigahertz. 

 

ii. Motherboard 

It is the central hub that connects and supports all other hardware components in the system. It is 

just one piece of circuitry for communication between the CPU, RAM, storage devices, and other 

peripherals. 

 

 

iii. Storage Devices 

The devices that are used to store data permanently or temporarily. Broadly they are classified into 

two major categories: Hard Disk Drive (HDD) and Solid-State Drives (SDD). 

iv. Random Access Memory (RAM) 

It is a volatile memory that stores data temporarily for quick access by the CPU. It is responsible 

for holding data and instructions that are currently used by the system. 

 



v. Graphics Processing Unit 

It renders images, animation, and videos on a computer screen. It can be integrated into the CPU 

or come as a separate graphics card. 

Vi mouse 

A computer mouse (plural mice, also mouses) is a hand-held pointing device that detects two-

dimensional motion relative to a surface. 

 

 

 

 

 

 

3.1 Uses of computer  

1. Business 

Almost every business uses computers nowadays. They can be employed to store and maintain 

accounts and personnel records, manage projects, track inventory and create presentations and 

reports. 

They enable communication with people both within and outside the business using various 

technologies, including e-mail. They can be used to promote the business and enable direct 

interaction with customers. 

 

 



2. Education 

Computers can be used to give learners audio-visual packages, interactive exercises, and remote 

learning, including tutoring over the internet. They can be used to access educational information 

from intranet and internet sources or via e-books. 

They can be used to maintain and monitor student performance, including through the use of online 

examinations, as well as to create projects and assignments. 

3. Healthcare 

Healthcare continues to be revolutionized by computers. As well as digitized medical information 

making it easier to store and access patient data, complex information can also be analyzed by 

software to aid discovery of diagnoses, as well as search for risks of diseases. 

Computers control lab equipment, heart rate monitors, and blood pressure monitors. They enable 

doctors to have greater access to information on the latest drugs, as well as the ability to share 

information on diseases with other medical specialists. 

4. Retail and Trade 

Computers can be used to buy and sell products online – this enables sellers to reach a wider market 

with low overheads, and buyers to compare prices, read reviews, and choose delivery preferences. 

They can be used for direct trading and advertising, too, using sites such as eBay, Craigslist, or 

local listings on social media or independent websites. 

5. Government 

Various government departments use computers to improve the quality and efficiency of their 

services. Examples include city planning, law enforcement, traffic, and tourism. Computers can 



be used to store information, promote services, communicate internally and externally, as well as 

for routine administrative purposes. 

6. Marketing 

Computers enable marketing campaigns to be more precise through the analysis and manipulation 

of data. They facilitate the creation of websites and promotional materials. They can be used to 

generate social media campaigns. They enable direct communication with customers through 

email and online chat. 

  



CHAPTER FOUR 

4.0 Start a document 

It’s often easier to create a new document using a template instead of starting with a blank page. 

Word templates come ready-to-use with pre-set themes and styles. All you need to do is add your 

content. 

Each time you start Word, you can choose a template from the gallery, click a category to see more 

templates, or search for more templates online. 

For a closer look at any template, click it to open a large preview. 

If you’d rather not use a template, click Blank document. 

Open a document 

Every time you start Word, you’ll see a list of your most recently used documents in the left 

column. If the document you’re looking for isn’t there, click Open Other Documents. 

If you’re already in Word, click File > Open and then browse to the file’s location. 

When you open a document that was created in earlier versions of Word, you see Compatibility 

Mode in the title bar of the document window. You can work in compatibility more or you can 

upgrade the document to use Word 2016.  

Save a document 

To save a document for the first time, do the following: 

1. On the File tab, click Save As. 

2. Browse to the location where you’d like to save your document. 

https://support.microsoft.com/en-us/office/download-free-pre-built-templates-29f2a18d-29a6-4a07-998b-cfe5ff7ffbbb


Note: To save the document on your computer, choose a folder under This PC or 

click Browse. To save your document online, choose an online location under Save As or 

click Add a Place. When your files are online, you can share, give feedback and work together 

on them in real time. 

3. Click Save. 

Note: Word automatically saves files in the .docx file format. To save your document in a 

format other than .docx, click the Save as type list, and then select the file format that you 

want. 

To save your document as you continue to work on it, click Save in the Quick Access Toolbar 

Open your document in Read Mode to hide most of the buttons and tools so you can get absorbed 

in your reading without distractions. 

1. Open the document you want to read. 

Note: Some documents open in Read Mode automatically, such as protected documents or 

attachments. 

2. Click View > Read Mode. 

3. To move from page to page in a document, do one of the following: 

 Click the arrows on the left and right sides of the pages. 

 Press page down and page up or the spacebar and backspace on the keyboard. You can 

also use the arrow keys or the scroll wheel on your mouse. 

 If you’re on a touch device, swipe left or right with your finger. 

Tip: Click View > Edit Document to edit the document again. 

 



Track changes 

When you’re working on a document with other people or editing a document yourself, turn 

on Track Changes to see every change. Word marks all additions, deletions, moves, and 

formatting changes. 

1. Open the document to be reviewed. 

2. Click Review and then on the Track Changes button, select Track Changes. 

Print your document 

All in one place, you can see how your document will look when printed, set your print options, 

and print the file. 

1. On the File tab, click Print. 

2. Do the following: 

 Under Print, in the Copies box, enter the number of copies you want. 

 Under Printer, make sure the printer you want is selected. 

 Under Settings, the default print settings for your printer are selected for you. If you want 

to change a setting, just click the setting you want to change and then select a new setting. 

3. When you’re satisfied with the settings, click Print. 

4.2  EDITING AND FORMATTING A DOCUMENT 

To edit a document, open the file in your preferred word processor (like Microsoft Word), 

then select the text you want to change and type in your edits; to format a document, highlight the 

text you want to style and use the toolbar options to change the font, size, alignment, bold, italic, 

underline, or other formatting features depending on your needs.  

Key steps for editing and formatting a document: 

 Open the document: Access the document you want to edit in your word processing software.  

 Select text: Click and drag your mouse over the text you want to modify.  

 Edit text: Type new text to replace the selected section.  



 Formatting options: 

o Font style: Choose a different font from the dropdown menu.  

o Font size: Adjust the text size using the size options.  

o Bold, Italic, Underline: Use the respective buttons to apply bold, italics, or underline formatting.  

o Alignment: Align text left, center, right, or justify using the alignment buttons.  

o Paragraph spacing: Modify the spacing between paragraphs.  

Important points to remember: 

 Highlighting text: 

To select specific text for formatting, simply click and drag your mouse over it.   

 Using the toolbar: 

Most formatting options are located on the toolbar within your word processor.  

 Shortcut keys: 

Many word processors have keyboard shortcuts for common formatting actions like Ctrl+B for 

bold or Ctrl+I for italic 

4.3 HOW TO USE CORELDRAW  

1.       Introduction CorelDraw 

2.       Starting  with CorelDraw 

Understanding Corel Draw Tools 

1.       Pick Tools and  Freehand Pick Tool 

2.       Shape Tools 

3.       Smudge Brush Tool and Roughen Brush Tool 

4.       Free Transform Tool 

5.       Smear Tool and  Twirl tool 

6.       Attract tool and Repel tool 



7.       Crop Tool and Knife Tool 

8.       Eraser Tool and Virtual Segment Delete Tool 

9.       Zoom Tool And Pan Tool 

10.   Freehand  Tool 

11.   Bezier Tool 

12.   Artistic Media Tool 

13.   Pen Tool 

14.   B-Spline Tool 

15.   Polyline Tool 

16.   Smart Fill And Smart Drawing 

17.   Ellipse, Polygon,  Star, Complex Star, Graph Paper and Spiral Tool and shapes 

18.   Text Tool (Artistic Text and  Paragraph text) 

19.   Blend Tool 

20.   Contour and Distort Tool 

21.   Drop Shadow Tool 

22.   Transparency Tool 

23.   Color Eyedropper tool 

24.   Outline Pen tool 

25.   Uniform Fill and Fountain Fill Tool 

26.   Texture  Fill 

27.   Interactive Fill 

28.   Mash Fill 

 



Understanding CorelDraw Basic 

1.       Save File, Export To jpg, pdf and import image 

2.       Object Position 

3.       Align and Distribute Object 

4.       Object order 

5.       Group, ungroup Object and Lock, unlock Object 

6.       Distributing object Same Space 

7.       Undo and Redo and Repeat Object 

8.       Insert page and insert page number 

9.       Fit text path 

10.   Weld Object 

11.   Trim Object 

12.   Intersect, Simplify, Front minus Back, Back Minus Front Object 

13.   Power clip object 

CorelDraw Project 

1.       Brochure Design 

2.       Business card Design 



CHAPTER FIVE 

5.0 RECOMMENDATION AND CONCLUSION 

5.1 RECOMMENDATION 

 I use this means to make the following recommendations concerning the training of 

students in Industrial Attachments 

i. I would like to recommend that the Engineering curriculum in the Polytechnics to adjust 

such as would provide going on industrial attachments for a longer period of time as opposed 

to 4 months or making the program to occur twice throughout an engineering degree 

program.  

ii. Allowances should be paid to students during their programme just like NYSC and not after. 

This would help them a great deal to handle some financial problems during their training 

course. 

iii. The SIWES coordinator and the polytechnic authority should try to stop the habit of rejecting 

students for SIWES program by the industries 

iv. The institution supervisor should make it a priority to visit their designated students in the 

various organization to update the student’s logbook 

v. Adequate space part should make available to save equipment from deplore condition. 

vi. More machines should be made available 

vii. Visiting of students during the SIWES program should be ensured by the Industrial Training 

Fund officials and college coordinators in order to ensure that students get necessary 

exposure and to boost their morale. 

 5.2 CONCLUSION 

 My 6months SIWES program was a huge success and a great time of acquisition of 

knowledge and skills. Through my training I was able to appreciate my chosen course of study 

even more, because I had the opportunity to blend the theoretical knowledge acquired from school 

with the practical hands-on application of knowledge gained here to perform very important tasks 

that contributed in a way to my productivity in the company. My training here has given me a 

broader view to the importance and relevance of civil Engineering in the immediate society and 



the world as a whole, as I now look forward to impacting it positively after graduation. I have also 

been able to improve my communication and presentation skills and thereby developed good 

relationship with my fellow colleagues at work. I have also been able to appreciate the connection 

between my course of study and other disciplines in producing a successful result. 

 The Student Industrial Work Experience Scheme (SIWES) is an interesting program that 

adds more value to students view and objectives of their fields of study. 

 The Student Industrial Work Experience Scheme (SIWES) has made a great impact in the 

life of every student that diligently and faithfully participated in the exercise, as a matter of fact, I 

particularly I’m living testimony to the training. 

 I hereby encourage and advice every student to be committed to the training scheme, 

having it in mind that the journey of a thousand miles begins with a footstep. 
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